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H ow to Use This Manual

Overview

Installing and Using Novell Online Documentation explains what Novell
online documentation is, how to set it up, and how to use it.

Online documentation can be installed in several different ways
depending on your groups’ needs. This document helps you decide
which setup best meets your needs and explains how to get that setup.

¢ Chapter 1, “Introducing Novell Online Documentation,” and
Chapter 2, “Planning for Online DocumentationOverview,”
contain conceptual information to help you take advantage of
installation flexibility.

¢ Chapter 3, “Installing and Setting Up Online Documentation,”
walks you through installation procedures.

¢ Chapter 4, “Configuring Online Documentation,” explains
configuration that may be necessary for customized installations.

¢ Chapter 5, “Using the DynaText Viewer,” covers the basics of using
the documentation viewer.

¢ Theappendixes provide reference information that you might want
when installing and configuring online documentation.



Your Comments

You can help us make our products and our documentation easier to
use by filling out the User Comments form at the end of this manual or
by writing to us at

Novell, Inc.

Technical Publications
MS C-23-1

122 East 1700 South
Provo, UT 84606 USA

We appreciate your comments.
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chapter 1

Overview

Introducing Novell Online
Documentation

Novell® online documentation allows you to electronically store the
manuals in the NetWare® documentation set, and then to access that
information from your workstation.

The online documentation is composed of two parts:

¢ The documentation database contains the books in the online
documentation set and may be available in several languages.

¢ The DynaText* viewer software allows you to read, search,
annotate, and print online documentation from any of the
following NetWare clients: Microsoft* (MS) Windows, OS/2*
running WIN-OS/2, Macintosh*, or UnixWare™.

If You Already Have Novell Online Documentation

Previous Novell online documentation was distributed with the
ElectroText™ viewer. The new DynaText viewer provides better
searching, public and private user annotations, and improved
document presentation.

The DynaText viewer cannot view the ElectroText books that were
distributed with earlier versions of NetWare, and the ElectroText
viewer cannot view DynaText books.

To conserve disk space and reduce confusion, we recommend removing

ElectroText directories and files. For complete information on removing
these files, see “Removing ElectroText Directories” on page 42.

Introducing Novell Online Documentation 1
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The following topics are discussed in this chapter.

Topic Page
Accessing Online Documentation 3
Planning for Multiple Documentation Collections 5
Referencing Public and Private Collections 5
Planning Online Documentation for Multilingual Use 6

Accessing Online Documentation

To access online documentation, you can use any of the following types
of workstation:

& Microsoft (MS) Windows

¢ OS/2 running WIN-OS/2

& Macintosh

& UnixWare
The workstation can be a standalone machine that has online
documentation files installed, or it can be networked to a server that has
online documentation files installed.
The documentation database and DynaText viewer can be accessed in

three ways: from the network, from a standalone workstation, or from
the product CD-ROM.
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From the Network

If you install the DynaText viewer and the documentation database on
the server, the documentation is available to all workstations logged in
to that network.

However, if the server or your connection to the network goes down,
you cannot access the documentation.

From a Standalone Workstation

If you install the DynaText viewer and the documentation database on
a standalone workstation, the documentation is available only to users
of that workstation.

This is limiting, but it allows documentation access if the server is
down.

From the Product CD-ROM

If you install the DynaText viewer on a local or network hard disk and
leave the documentation database on the product CD-ROM, you save
disk space.

However, additional configuration is required and information access
is slower than if the documentation were accessed from the hard disk.

For standalone access, the CD-ROM must be set up and working on the
workstation. For network access, the CD-ROM must be mounted on the
server as a NetWare® volume.

4 Installing and Using Novell Online Documentation



Planning for Multiple Documentation Collections

Novell® online documentation is designed to be installed in collections.
A collection contains one or more books. Collections can be installed
and managed independent of viewers.

Each Novell product ships with its own collection, which is installed in
a collection-specific directory. For example, the documentation for
NetWare 4.1 is a collection installed in a directory named NW41. The
documentation for NetWare 3.12 is a collection installed in a directory
named NW312A.

You can install multiple collections at a single location. For example,
both the 4.1 collection and the 3.12 collection might be installed at
SYS:DOC on the same server.

Or you can install collections across several locations. For example, the
4.1 collection might be installed on a NetWare 4.1 server, and the 3.12
collection might be installed on a 3.12 server.

To provide access to multiple collections, you must reference each
collection directory in the online documentation configuration files.

Referencing Public and Private Collections

Collections are referenced either in the system configuration file or in a
platform-specific configuration file, depending on who is to have access
to the documentation.

Referencing a collection in the system configuration file makes it public,
available for all network users to view. Public collections must be
installed on the network in a directory where users have rights to access
the documentation.

Referencing a collection in a platform-specific configuration file that
resides in an area of restricted access makes the collection private,
available for viewing only by users with sufficient rights. Private
collections can be installed on a local hard disk or in a network directory
where user rights are restricted.

Planning for Online Documentation 5



The DynaText viewer displays both public collections referenced in the
system configuration file and private collections referenced in a user’s
platform-specific configuration file.

For complete configuration information see, Chapter 4, “Configuring
Online Documentation,” on page 29.

Planning Online Documentation for Multilingual Use

Novell online documentation is available in several languages
depending on the Novell product. Each language requires between 40
and 60 MB of disk space.

Platform-specific considerations for multilingual documentation are
explained in the following sections.

Specifying Language for Documentation on MS Windows and 0S/2

NoteVI
v

Documentation language can be set dynamically with the
NWLANGUAGE parameter for each workstation. Using
NWLANGUAGE allows different workstations to view the same
collection in different languages.

To set NWLANGUAGE, add the following line to the workstation
AUTOEXEC.BAT file:

set nwlanguage=Ilanguage

Place no spaces in nwlanguage=Ilanguage; replace language with the
name of the directory containing the desired documentation language.
Language directory names are detailed in Table A-1, “Language
Directory Names,” on page 39.

0S/2 users should set the NWLANGUAGE parameter in the AUTOEXEC.BAT
file for the WIN-OS/2 session.

For a single workstation to view documentation in multiple languages,
override the NWLANGUAGE parameter by explicitly referencing each
language directory in the configuration files.

For a complete explanation of configuration files see
Chapter 4, “Configuring Online Documentation,” on page 29.
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Specifying Language for Documentation on Macintosh

Documentation language is determined by the language of the
DynaText viewer. For example, the French viewer displays French
documentation and the English viewer displays English
documentation.

For a single workstation to view documentation in multiple languages,
install the viewer for each language and then reference collection
language directories in the configuration files. Language directory
names are detailed in Table A-1, “Language Directory Names,” on
page 39.

To simplify running multiple viewer languages, create an alias for each
viewer. For this procedure, see “Creating an Alias to the Macintosh
DynaText Viewer” on page 22.

Specifying Language for Documentation on UnixWare

UnixWare uses the LANG variable to specify environment language.
Novell online documentation maps the value of this variable to the
NWLANGUAGE parameter to set collection and viewer languages.

The mapping between LANG and NWLANGUAGE is performed by
the dtext shell script in \usr\X\bin.

For a single workstation to view documentation in multiple languages,
override the NWLANGUAGE parameter by explicitly referencing each
language directory in the configuration files. Language directory names
are detailed in Table A-1, “Language Directory Names,” on page 39.

Planning for Online Documentation 7
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chapter
i 3 Installing and Setting Up Online
Documentation

Overview

The following types of documentation installation and access are
discussed in this chapter.

Topic Page
Installing Online Documentation for Network Viewing 9
Installing Online Documentation for Standalone Workstation 15
Viewing

Accessing Online Documentation from a CD-ROM Drive 25

Installing Online Documentation for Network Viewing

MS Windows, OS/2 running WIN-OS/2, and Macintosh clients can
access online documentation from the network.

UnixWare™ clients should access online documentation using the
procedure in “Installing Online Documentation on a UnixWare
Workstation” on page 22.

You can install online documentation for the network using the
INSTALL or NCOPY utility.

¢ INSTALL

Provides menus and prompts to guide you through installing
online documentation using default directory structures.

This process can be done at the initial NetWare® software
installation or any time after initial installation using the
INSTALL.NLM program.

Installing and Setting Up Online Documentation



Importantv

Prerequisites

& NCOPY

Allows you to use nondefault locations for the online
documentation database and the viewer for MS Windows and
0S/2. The Macintosh and UnixWare viewers cannot be installed
with NCOPY.

NCOPY requires you to understand source and destination
directories and file dependencies. For an explanation of the online
documentation directory structure, see Appendix A, “Directories
and Files,” on page 37.

NCOPY does not work for products distributed on diskettes because of file
compression required for diskette distribution. Use NCOPY only if the
product is distributed on CD-ROM.

Online documentation files require a NetWare server with the
following:

Checklistv [ Minimum of 60 MB free hard disk space

If only the viewer files will be installed on the disk and the online
documentation files will be read directly from the CD-ROM, only
6 MB of disk space are necessary for the first viewer language
(additional viewer languages require 2 MB each).

CD-ROM drive that can read 1SO 9660-formatted CD-ROM disks

The drive should be installed according to the manufacturer’s
instructions.

10 Installing and Using Novell Online Documentation



Procedures

Use one of the following network install options.

Network Install Options Page
Using INSTALL to Install Online Documentation 11
Using NCOPY to Install Collections 12
Using NCOPY to Install the DynaText Viewer for MS Windows and 14

0s/2

Using INSTALL to Install Online Documentation
Procedure‘? 1. At the console prompt, type

LOAD INSTALL <Enter>

2. From “Installation Options,” choose “Product Options.”

3. From “Other Installation Action,” choose “Choose an Item or

Product Listed Above.”

4. Choose “Install Online Documentation and Viewers.”

5. Press <F3> and enter the path to the documentation CD-ROM.

¢ If the CD-ROM is mounted as a DOS device, enter the drive

letter.

¢ If the CD-ROM is mounted as a NetWare volume, enter the

volume name followed by a colon.

For example to specify a volume named NW410DOC, you

would type

NW410DOC: <Enter>

Alist of available file groups appears.

6. Select both the documentation database and DynaText viewer
file groups for the platform and language you want to use.

Installing and Setting Up Online Documentation 11



Note"l
\4

Accept the marked file groups by pressing <F10>.

Preliminary install files are copied.

Specify where to install the documentation database.

The default location is SYS:DOC. If you change the default, edit the
system configuration file, SYSDOCS.CFG, as explained in
“SYSDOCS.CFG” on page 30.

The default location of the viewer files, SYS:DOCVIEW, cannot be changed
using INSTALL.NLM. To install the viewer in a nondefault location, see
“Using NCOPY to Install the DynaText Viewer for MS Windows and 0s/2”
on page 14.

Set up a client workstation to access the viewer.

Client Reference

MS Windows or OS/2 “Setting Up a DynaText Viewer in MS Windows
running WIN-OS/2 or WIN-OS/2” on page 18

Macintosh “Creating an Alias to the Macintosh DynaText

Viewer” on page 22

UnixWare “Installing Online Documentation on a

UnixWare Workstation” on page 22

Using NCOPY to Install Collections

Procedure‘?

This procedure explains how to copy the document database and
configuration files from the \DOC directory structure of the CD-ROM
to the SYS:\DOC directory on your NetWare server.

1.

Copy the document database from the \DOC\anguage
directory to the SYS:\DOC\ianguage directory on your server.

Replace language with the directory name of the language you
want.

For example, to copy the English document database where D: is
the CD-ROM drive and drive X: is mapped to
SYS:\DOC\ENGLISH, you would type

NCOPY D:\DOC\ENGLISH\*.* X: /S <Enter>

12 Installing and Using Novell Online Documentation



The collection is installed.

2. Update the system configuration file, SYSDOCS.CFG.

*

If this is a first-time install, copy SYSDOCS.CFG from the
\PUBLIC directory of the CD-ROM to the SYS:\PUBLIC
directory on the server.

For example, if D: is the CD-ROM drive and drive Z: is mapped
to SYS:\PUBLIC, you would type
NCOPY D:\PUBLIC\SYSDOCS.CFG Z: <Enter>

If you’ve used nondefault directory structures, you might need
to modify configuration files. For more information, see Chapter
4, “Configuring Online Documentation,” on page 29.

If SYSDOCS.CFG already exists on the network, add the new
collection name to the SYSDOCS.CFG collection line.

For more information, see “SYSDOCS.CFG” on page 30.

3. (Conditional) If you have not previously installed viewer files,
do so.

Client

Reference

MS Windows or 0S/2  “Using NCOPY to Install the DynaText Viewer for MS
running WIN-OS/2 Windows and OS/2” on page 14

Macintosh “Using INSTALL to Install Online Documentation” on
page 11
UnixWare “Installing Online Documentation on a UnixWare

Workstation” on page 22

Installing and Setting Up Online Documentation 13



Using NCOPY to Install the DynaText Viewer for MS Windows and 0S/2

14

Procedurew
Imponantv

Suggestionv

This procedure explains how to copy the DynaText viewer for MS
Windows or OS/2 running WIN-OS/2 from the \DOCVIEW directory
structure of the CD-ROM to the SYS:\DOCVIEW directory on your
NetWare server.

1. Copy the DynaText viewer files from the \DOCVIEW directory

structure of the CD-ROM to the \DOCVIEW directory on your
hard disk.

The \DOCVIEW directory must be at the root because of DOS pathname
limitations.

For example, if drive X: is mapped to SYS\DOCVIEW and D: is the
CD-ROM drive, you would type

MD X:\DOCVIEW\DTAPPWIN

NCOPY D:\DOCVIEW\DTAPPWIN\*.* X:\DOCVIEW\DTAPPWIN
/8 <Enter>

to copy all of \DOCVIEW\DTAPPWIN and

MD X:\DOCVIEW\DTDATWIN
NCOPY D:\DOCVIEW\DTDATWIN\*.* X:\DOCVIEW\DTDATWIN
/s <Enter>

to copy all of \DOCVIEW\DTDATWIN.

The subdirectories under the \DTDATWIN directory contain language
support files for all available languages. Each language’s support files
require about 2 MB of disk space.

If you do not need all of the languages, save space by deleting the language
subdirectories for the languages you will not use. Language subdirectories
are named with three-letter language codes as shown in Table A-2,
“Language Codes,” on page 40.

. Set up a client workstation to access the viewer.

See “Setting Up a DynaText Viewer in MS Windows or WIN-OS/2”
on page 18.

. (Conditional) If you have not installed a documentation

database, do so.

See “Using NCOPY to Install Collections” on page 12.

Installing and Using Novell Online Documentation



Installing Online Documentation for Standalone
Workstation Viewing

Note"’
v

Use this installation only if the documentation is distributed on
CD-ROM. This method of installation does not work for products
distributed on diskettes because of file compression required for
diskette distribution.

For standalone access to documentation distributed on diskettes, install
documentation on the server using the INSTALL.NLM program, which
decompresses files. Then copy files to a client that can be used as a standalone
workstation.

You can install online documentation on the following NetWare clients
supported by DynaText:

Client Reference

MS Windows or 0S/2  “Installing Online Documentation on an MS Windows
running WIN-OS/2 or OS/2 Workstation” on page 16

Macintosh “Installing Online Documentation on a Macintosh
Workstation” on page 20

UnixWare “Installing Online Documentation on a UnixWare
Workstation” on page 22

Installing and Setting Up Online Documentation 15



Installing Online Documentation on an MS Windows or OS/2 Workstation

16

Checklistv

Procedure‘v
Importantv

Prerequisites

The workstation that the online documentation files are installed on
must have the following;:

(d Minimum of 60 MB free hard disk space

If only the viewer files will be installed on the disk and the online
documentation files will be read directly from the CD-ROM, only
6 MB of disk space are necessary for the first viewer language
(additional viewer languages require 2 MB each).

(1 CD-ROM drive that can read I1SO 9660-formatted CD-ROM disks.

The drive should be installed and set up according to the
manufacturer’s instructions.

Procedure

The following procedure copies the documentation database and
DynaText viewer to an MS Windows or OS/2 workstation.

1. Copy the DynaText viewer files from the \DOCVIEW directory

structure of the CD-ROM to the \DOCVIEW directory on your
hard disk.

The \DOCVIEW directory must be at the root because of DOS pathname
limitations.

For example, if C:\DOCVIEW will contain the viewer and D: is
your CD-ROM drive, you would type

XCOPY D:\DOCVIEW\DTAPPWIN\*.* C:\DOCVIEW\DTAPPWIN
/s <Enter>

to copy all of \DOCVIEW\DTAPPWIN and

XCOPY D: \DOCVIEW\DTDATWIN\*.* C:\DOCVIEW\DTDATWIN
/s <Enter>

to copy all of \DOCVIEW\DTDATWIN.

Installing and Using Novell Online Documentation



Suggestionv

The subdirectories under the \DTDATWIN directory contain language
support files for all available languages. Each language’s support files
require about 2 MB of disk space.

If you do not need all of the languages, save space by deleting the language
subdirectories for the languages you will not use. Language subdirectories
are named with three-letter language codes as shown in Table A-2,
“Language Codes,” on page 40.

. Copy the book database from the \DOC\/anguage directory

structure of the CD-ROM to the \DOC\/anguage directory on
your hard disk.

For example, if the C:\DOC\ENGLISH will contain the document
database and D: is your CD-ROM drive, you would type

XCOPY D:\DOC\ENGLISH\*.* C:\DOC\ENGLISH /S <Enter>

. Reference collections in the DYNATEXT.INI file.

By default, DYNATEXT.INI is located in
\DOCVIEW\DTAPPWIN. Use any text editor to modify the file.

In the COLLECTION= line, enter the path to the collecti(_)n.

For example, if the English 4.1 collection is in a default location on
the hard drive, the COLLECTION= line should read

COLLECTION=\DOC\ENGLISH\NW41l=NetWare 4.1 manuals

. Set up the workstation to access the viewer.

Continue with the next section, “Setting Up a DynaText Viewer in
MS Windows or WIN-OS/2.”

Installing and Setting Up Online Documentation 17



Setting Up a DynaText Viewer in MS Windows or WIN-OS/2

Checklistv

Procedure\?

Note"’
v

After documentation has been installed, you can set up access to the
DynaText viewer on your MS Windows or WIN-OS/2 desktop.

Prerequisites

The computer that DynaText is viewed on must have the following:

3

L U

VGA or Super VGA display card and monitor

Hercules* monochrome or EGA display cards and monitors also
work but might compromise presentation.

Minimum of 4 MB of RAM

MS Windows 3.x or OS/2 v2.1x

(Conditional) If you will be viewing online documentation stored on
a NetWare server, you must first set up the workstation as a

NetWare client.

See the NetWare Client for DOS and MS Windows User Guide or
the NetWare Client for OS/2 User Guide for information.

Procedure

1.

(Conditional) To view online documentation using a viewer
installed on the network, map a drive to the volume containing
the viewer application files (usually servername\SYS:).

Ensure that the following line is in the AUTOEXEC.BAT file:

set nwlanguage=language

Place no spaces in nwlanguage=Ilanguage; replace language with
the name of the language for the book text (english, deutsch, espanol,
italiano, or francais

This variable specifies which set of electronic books will be viewed.
The name must match one of the subdirectories under the \DOC
directory.

0S/2 users should set the NWLANGUAGE parameter in the
AUTOEXEC.BAT file for the WIN-OS/2 session.

18 Installing and Using Novell Online Documentation



Importantv

3. To make the language setting take effect, reboot or enter “SET
NWLANGUAGE=/anguage” at the command line.

4. Start MS Windows or WIN-0OS/2.

5. Create a program icon for DynaText.

5a.

5b.
5c.
5d.
5e.

5f.

5g.

5h.

Ensure that the program group you want to place the icon
in is active, and then choose “New” from the “File” menu.

Select “Program Item” and choose “OK.”
Enter “Documentation” for the description of the icon.
Place the cursor in the “Command Line” field.

Choose “Browse” and then the drive letter where the
documentation is installed.

Browse through the directories to select “DTEXTRW.EXE”
in the \DOCVIEW\DTAPPWIN directory (or whichever
directory you have installed the viewer files in).

Set the “Working Directory” to the directory containing
DTEXTRW.EXE.

If the “Working Directory” is not set to this directory, DynaText
displays empty collections.

Choose “OK.”

A Documentation icon appears. DynaText is now ready to run
on your MS Windows workstation.

Installing and Setting Up Online Documentation 19



Installing Online Documentation on a Macintosh Workstation

The following procedure installs the DynaText viewer and the
documentation database on a Macintosh workstation.

Prerequisites
Before you install, make sure you have the following:

Checklist [ A Macintosh SE or later (Centris or Quadra series Macintosh is
v recommended)

System 7.0 or later
NetWare for Macintosh

Minimum of 3 MB free RAM available

E R H

A utility that decompresses “BinHexed” Stufflt archives

You can do this with any of the Stufflt programs sold by Aladdin
Systems, or you can use the freeware utility Stufflt Expander which
is available on most popular Macintosh bulletin boards and FTP
sites.

(1 Minimum of 60 MB free hard disk space

If only the viewer files will be installed on the disk and the online
documentation files will be read directly from the CD-ROM, only
4.5 MB of disk space are necessary for the first viewer language
(additional viewer languages require 2 MB each).

(1 CD-ROM drive that can read 1SO 9660-formatted CD-ROM disks.

The drive should be installed and set up according to the
manufacturer’s instructions.

20 Installing and Using Novell Online Documentation



Procedure

Procedure‘w 1.

Copy the DYNATEXT.HQX file from the
“DOCVIEW:DTAPPMAC:/anguage” folder on the CD-ROM to
your Macintosh.

Launch the application which decompresses Stufflt archives.

Open and decompress the DynaText archive.

A folder called “DYNATEXT Folder” is created on your Macintosh
at the location that you specify, replacing any previous folder called
“DYNATEXT Folder” that might exist at this location.

Place this folder at the root to reduce configuration requirements.

Copy the documentation database from the “DOC:/anguage”
folder on the CD-ROM to a DOC:/anguage folder on your hard
disk.

Place this folder at the root to reduce configuration requirements.

Reference the location of the documentation database in the
Collection= line of the DYNATEXT.CFG configuration file.

DYNATEXT.CFG is located in
“DYNATEXT Folder: DTAPPMAC:ENGLISH.”

If you installed the “DynaText Folder” or the “DOC” folder at a
location other than the root of your hard disk, or if you are leaving
the book database on the CD-ROM or on the NetWare server, you
must edit the DYNATEXT.CFG file.

Use any text editor and follow the instructions found in
DYNATEXT.CFG.

For more information about configuration files, see Chapter 4,
“Configuring Online Documentation,” on page 29.
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Creating an Alias to the Macintosh DynaText Viewer

Creating an alias for the DynaText viewer simplifies access to the
DynaText viewer. The alias eliminates the need to browse through
volumes and folders each time you want to use DynaText.

Procedure

Procedure‘? 1. Select the DynaText program by browsing to its install location
and clicking on its icon.

2. From the “File” menu, choose “Make Alias.”

A copy of the program icon appears.

3. Drag the DynaText alias icon to a more easily accessible
location.

DynaText is now available through the DynaText alias icon.

Installing Online Documentation on a UnixWare Workstation

Installing Viewer Files

The following procedure installs the DynaText viewer on a UnixWare
client. The documentation database can be installed on a NetWare
server that the client is attached to.

The UnixWare viewer software and data files are provided in two tar
files named dtappuw.tar and dtdatuw.tar, respectively. These files are
on your NetWare 4.1 documentation CD in the DTAPPUW and
DTDATUW directories.

Procedure

Procedure 1. Copy the dtappuw.tar and dtdatuw.tar files from the CD to a
E location on the NetWare server visible to the UnixWare client
and then copy them from that location to the client’s /tmp
directory.

You might be able to perform this in a single operation if the CD is
visible from the UnixWare client.
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2. Become root (superuser) on the UnixWare client.

3. Execute the following commands:

tar xvfo /tmp/dtappuw.tar
tar xvfo /tmp/dtdatuw.tar

. Log in as the UnixWare client’s user. In the user’s home

directory, enter the following:

In -s /usr/X/bin/dtext Document_Viewer
This creates a program icon on the user’s desktop.

After the DynaText viewer is installed, you must specify the
location of your DynaText documents to complete the installation.
See “Specifying the Location of Document Directories” on page 23.

. (Conditional) If there are multiple users, repeat Step 4 for each

one.

Specifying the Location of Document Directories

Procedure‘?

You need root privileges to perform these steps.

Procedure

1. Obtain the full path name of the document tree on your

NetWare server in the form that is used on your UnixWare
client.

The form will vary depending on whether the UnixWare client is
attached to NetWare as a simple NetWare client or attached through
an NFS* mount.

For example, suppose that the NetWare 4.1 document set has been
installed on the NetWare server PACIFIC-SALES on the volume
VOLA4 in the directory \DOC\ENGLISH\NW41.

On a UnixWare system attached as a simple NetWare client, the
directory PACIFIC-SALES\VOL4:DOC would be specified as

/ .NetWare/pacific-sales.nws/vold.nwv/doc
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On a UnixWare system that accesses the NetWare server through
NFS, on the other hand, this same directory could be specified as

/pacific/vold/doc

The exact form will depend on the way that the NetWare file system
has been mounted in UnixWare.

2. Once you have determined the full path name of the doc
directory, normalize it by establishing a symbolic link between
the real path name and a link point named /doc.

For the first example described in Step 1, the command would be

1n -s /.NetWare/pacific-sales.nws/vol4.nwv/doc
/doc

For the second example in described in Step 1, this command
would be entered as

1n -s /pacific/vol4/doc /doc

In either case, the viewer can now see the NetWare 4.1 document set
as /doc/english/nw41.

3. (Optional) Verify that the symbolic link has been specified
correctly.

For example, you could enter the following command:

as /doc/english/

You should see a list of the document collections that have been
installed on the NetWare server.

4. Establish a similar link between the SYS:PUBLIC directory on
the NetWare server and a link point named /public.

For the two examples described in Step 1 and Step 2, you would use
one of the following commands:

ln -s /.NetWare/pacific-sales.nws/sys.nwv/public
/public

1n -s /pacific/sys/public /public
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In either case, the viewer sees the NetWare document configuration
file PACIFIC-SALES\SYS:PUBLIC\SYSDOCS.CFG as
/public/sysdocs.cfg.

5. (Optional) Verify that the link has been specified correctly.
For example, you could enter the following command:

ls /public/

You should see a list of all the files in the NetWare server’s
SYS:PUBLIC directory, including the SYSDOCS.CFG file.

Accessing Online Documentation from a CD-ROM Drive

Note"’
\4

Installing the DynaText viewer on a local or network hard disk and
leaving the documentation database on the product CD-ROM saves
disk space. This setup requires only 6 MB of disk space for the first
viewer language (additional viewer languages require 2 MB each).
However, information access is slower than if the documentation were
accessed from the hard disk.

It is possible to run both the book database and the viewer software for
MS Windows or OS/2 directly from the CD-ROM. (To do this, create a
program icon that points to the CD-ROM as explained in Step 5 on
page 19, and the online documentation will be accessible.)

Although the online documentation viewer can be run from the
CD-ROM, performance is slower. Therefore, we recommend that you
install the viewer software on the NetWare disk or on your local hard
disk, and then access the book database directly from the CD-ROM.

The Macintosh and UnixWare viewers cannot be run from the CD-ROM. Install
them on a hard disk.

Installing and Setting Up Online Documentation 25



Procedure

Procedure‘;a 1. Set up the CD-ROM.

¢ For standalone access, the CD-ROM must be set up on the
workstation. Follow the manufacturer’s instructions.

& For network access, the CD-ROM must be mounted on the
server as a NetWare volume. For more information see,
Appendix B, “Mounting a CD-ROM as a NetWare Volume,” on

page 43.

2. Install the viewer on the network or on a standalone machine.

Use the following table to locate viewer installation instructions for

your platform.

Client Network Installation
Reference

Standalone Installation
Reference

MS Windows or 0S/2 “Using INSTALL to

running WIN-OS/2 Install Online
Documentation” on
page 11

Macintosh “Using INSTALL to
Install Online
Documentation” on
page 11

UnixWare N/A

“Installing Online
Documentation on an
MS Windows or OS/2
Workstation” on

page 16

“Installing Online
Documentation on a
Macintosh Workstation”
on page 20

“Installing Online
Documentation on a
UnixWare Workstation”
on page 22

3. Reference the location of SYSDOCS.CFG (/PUBLIC on the CD-
ROM) in the SYSCONFIG line of the platform-specific

configuration file.
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Use the following table to locate configuration file information.

Client Reference

MS Windows or OS/2 “DYNATEXT.INI” on page 31
running WIN-OS/2

Macintosh “DYNATEXT.CFG” on page 31
UnixWare “.ebtrc” on page 32
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A 4
chapter .
4 Configuring Online Documentation

Overview

The following topics are discussed in this chapter.

Topic Page
When to Edit Configuration Files 29
How to Edit Configuration Files 30

When to Edit Configuration Files

If your installation meets any of the following criteria, you should edit
the configuration files:

& Documentation files are installed somewhere other than \DOC and
\DOCVIEW, which are at the root of the same drive or volume.

¢ Simultaneous access to multiple languages is required.
¢ Multiple collections are installed with separate install procedures.

¢ Some installed collections are for private viewing only.
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How to Edit Configuration Files

DynaText uses two types of configuration files:
#® A system configuration file: SYSDOCS.CFG

¢ A platform-specific configuration file:

Platform Filename

MS Windows and OS/2 DYNATEXT.INI
running WIN-OS/2

Macintosh DYNATEXT.CFG
UnixWare .ebtrc

Both the system configuration file and the platform-specific
configuration files are text files and can be edited with any text editor.
SYSDOCS.CFG

SYSDOCS.CFG references the location of public collections. No other
configuration options are specified in SYSDOCS.CFG.

This file contains a section for each platform that references the location
of the documentation databases. Edit the collection line in the section
specific to your platform.

If you have multiple public collections, separate each collection
reference with a semicolon and no space.

SYSDOCS.CFG should reside in the SYS:PUBLIC directory on the
server or in the \PUBLIC directory on the CD-ROM.
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DYNATEXT.INI

Importamv

DYNATEXT.CFG

DYNATEXT.INI, the DynaText configuration file for MS Windows and
WIN-OS/2, references private collections and points to SYSDOCS.CFG,
which references public collections.

DYNATEXT.INI also references the location of resource files for the
viewer and defines viewer presentation characteristics such as color
and window location.

This file is self-documenting; each parameter is explained within the
file. To make modifications, use the instructions provided for each
section.

DYNATEXT.INI should reside in the \DOCVIEW\DTAPPWIN
directory. To provide for individual setups, copy DYNATEXT.INI to the
user’s Windows directory, where it takes precedence over other
versions of the file.

If a user has a local copy of the DYNATEXT.INI file (a copy in the user's Windows
directory), the local copy—not the public copy on the server—is used by the
viewer.

For this user to view public collections, the SYSCONFIG= line in the local
DYNATEXT.INI needs to be modified to specify the path to the SYSDOCS.CFG
file.

DYNATEXT.CFG, the Macintosh DynaText configuration file,
references private collections and points to SYSDOCS.CFG, which
references public collections. DYNATEXT.CFG also references the
location of resourece files for the viewer.

This file is self-documenting; each parameter is explained within the
file. To make modifications, use the instructions provided for each
section.

DYNATEXT.CFG should reside in the DTAPPMAC:language folder,

which is located in DOCVIEW on the server or in the local DynaText
Folder.
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.ebtrc

The .ebtrc file, the UnixWare™ DynaText configuration file, references
private collections and points to SYSDOCS.CFG, which references
public collections.

This file is self-documenting; each parameter is explained within the
file. To make modifications, use the instructions provided for each
section.

The .ebtrc file should reside in the /etc/opt/dynatext directory. If a

version of the .ebtrc file is also located in the user’s home directory, that
version takes precedence over the version in /etc/opt/dynatext.
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Using the DynaText Viewer

Overview

After the online documentation files and the DynaText viewer software
have been installed on the server or a local disk, and a client or
standalone computer has been set up to view the files, you can run
DynaText.

The following topics are discussed in this chapter.

Topic Page
Opening a Book 33
Navigating through a Book 34
Using the Master Index 35
Printing from DynaText 36

Opening a Book

Procedure‘? 1. Choose the Documentation icon on your desktop.

The DynaText application starts, and names of the available
collections appear.

2. Choose the name of the collection containing the book you
want to view.

Names of the books in the collection appear.
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3. Choose the name of the book you want to view.

The text and the Table of Contents outline for the book you

specified appear.

Navigating through a Book

After the book is open, you can do the following.

Task

Procedure

Move directly to a specific
section of the book

Click on the section title in the Table of
Contents outline window.

You can click on the “Plus Sign” icon to expand
the Table of Contents outline.

Read the book’s text
sequentially

Use the scroll bar on the right side of the text
window.

Adjust the text size

Choose “Enlarge” or “Reduce” from the “View”
menu.

View a graphic or table

Double-click on the icon representing the
graphic or table.

Close the graphic or table window when you
are finished viewing it.

Move to another section that
is referenced in the text

Click on the underlined, colored text. The
display moves to the referenced section.

If the referenced section is in a different book,
a new window opens displaying the other book.
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Task Procedure

Locate a specific word or Type the word or phrase in the “Find” field and
phrase in the book then press <Enter>. The text is scrolled to the
first occurrence of the word or phrase.

The number of occurrences in each section of
the book is listed in the Table of Contents
outline window. Choose a section title to jump
to the first occurrence of the word or phrase in
that section.

For more complex searches, choose “Search
Forms” from the “Book” menu.

Go back to the section you  Choose “Go Back” from the “Book” menu, or
just read choose the “Go Back” icon on the toolbar.

Using the Master Index

In addition to DynaText’s search feature, you can use the NetWare®
Master Index to locate information. The Master Index is the online
equivalent of the traditional paper index. Most NetWare collections
have a Master Index.

Procedure‘? 1. From the collection window, choose the Master Index.

2. Locate the topic you want by using the alphabetical table of
contents.

3. Choose the topic’s index marker (§).

Anew window appears, with the referenced book open at the
topic’s location.
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Viewing Page Numbers

DynaText allows you to view page numbers online similar to the page
numbers in a paper manual. This can be a quick way to reference a
specific section of text.

Procedure‘? 1. From the “View” menu, choose “Main.”

2. Select “Indexed.”
The text view changes to include bracketed page numbers.

If you print a section when page numbers are visible, the printout
provides two pagination schemes: the pagination turned on from
the “View” menu and the pagination indicating the number of
pages for that particular print job.

Printing from DynaText

DynaText allows you to print as little as a section or as much as an entire
book.

Procedure\;? 1. Select a book.
2. From the “File” menu, choose “Print.”

3. Use the “Print” dialog to select the sections of the book you
want to print.

4. Choose “Print.”

Selected sections begin printing. Figures and tables that do not
appear inline in DynaText will print inline.

For More Information

For complete information on the use of DynaText, choose the “Reader
Guide” option from the DynaText “Help” menu.
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appendix
A Directories and Files

Overview

This appendix outlines default documentation directory structures.

The following topics are discussed in this appendix.

Topic Page
DynaText Directory Tree 37
ElectroText Directory Tree 41
Removing ElectroText Directories 42

DynaText Directory Tree

Novell® documentation databases are installed by default in a root
directory named \DOC, which can be on a local hard disk, a NetWare®
volume, or the documentation CD-ROM.

The DynaText viewers for MS Windows, OS/2 running WIN-OS/2,
Macintosh, and UnixWare™ software are, by default, in a root directory
named \DOCVIEW, which can be on a local hard disk or on a NetWare
volume.

A system configuration file, SYSDOCS.CFG, is located in \PUBLIC,
which can be on volume SYS: or the documentation CD-ROM.

The default installation of online documentation is shown in the
following figure.

Directories and Files 37



Figure A-1
DynaText Directory
Tree
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\DOC Directory

Table A-1

The \DOC directory structure does not change for any of the platforms.
It contains the documentation database in multiple languages and the
files that support the databases.

¢ Language directories

Language directories are named in their native language as
outlined in the following table.:

Language Directory Names

Language Directory Name
English english

French francais
German deutsch

Italian italiano
Spanish espanol

Each language directory contains a COLNAMES.LST file (a listing
of available documentation collections for each language) and a
directory for each document collection (NW41 for NetWare 4.1, for
example).

PUBNOTES directory

Created by default when the viewer is first accessed. It stores all
public annotations made using the DynaText viewer.

To prohibit users from making public annotations, keep the default
rights assigned to this directory.

To allow users to make public annotations, assign them Read,
Write, and Create rights for this directory.
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\DOCVIEW Directory

The \DOCVIEW directory contains viewer executables and language
and viewer support files. Language support directories use a unique
three-letter code to identify the language.

Table A-2
Language Codes
Language Language Code
English enu
French fra
German deu
Italian ita
Spanish esp

MS Windows and WIN-OS/2

& \DTAPPWIN directory

Contains the viewer executables and the configuration file,
DYNATEXT.INIL

& \DTDATWIN directory

Contains bitmaps and icons used by the viewer, viewer version
information, translated versions of the viewer, language codes, and
the DynaText Reader Guide.

Macintosh

¢ \DTAPPMAC directory

Contains directories for the Macintosh viewer executables and
language configuration files.

¢ \DTDATMAC directory

Contains files used by the Macintosh viewer executable.
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UnixWare

¢ \DTAPPUW directory

Contains the tar file for the UnixWare viewer files.

¢ \DTDATUW directory

Contains the tar file for the UnixWare data directories.

\PUBLIC Directory

The \PUBLIC directory contains the SYSDOCS.CFG file, which
references public collections for all platforms.

ElectroText Directory Tree

Previous Novell online documentation was distributed with the
ElectroText™ viewer.

Most Novell documentation has been converted to use the DynaText
viewer. If your documentation has been updated to use the DynaText
viewer, we recommend you remove the ElectroText directories and
files.

The default directory structure for ElectroText documentation is shown
in the following figure.

Figure A-2
ElectroText
Directory Tree
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Removing ElectroText Directories

42

Procedurew 1.

Flag ElectroText collection and help subdirectories as
“Normal.”

For example, if drive X: is mapped to \DOC\language, you would
type

FLAG X:NW40\*.* N /S <Enter>
FLAG X:ETHELP\*.* N /S <Enter>

At \PUBLIC, remove the APPSIT.DLL and ET.EXE files.

In MS Windows File Manager, select the APPSIT.DLL and ET.EXE
files and choose “Delete” from the “File” menu.

At \PUBLIC\NLS\/anguage, remove the ETMSGS.DLL file.

In File Manager, select the ETMSGS.DLL file and choose “Delete”
from the “File” menu.

At\DOC, remove the \DATA directory and all its subdirectories.

In File Manager, select the \DOC\DATA directory and choose
“Delete” from the “File” menu.

At \DOC\/anguage, remove the \ETHELP directory and all its
subdirectories.

In File Manager, select the \DOC\language \ETHELP directory and
choose “Delete” from the “File” menu.

At \DOC\ianguage, remove the NOVELL.ETL file.

In File Manager, select NOVELL.ETL and choose “Delete” from the
“File” menu.

At \DOC\/anguage, remove the collection directory and all its
subdirectories.

In File Manager, select the \DOC\language\NW40 directory and
choose “Delete” from the “File” menu.
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appendix B
Mounting a CD-ROM as a NetWare
Volume
Prerequisites
[ Access to the server console or a remote console session with the

Checklistv

Note‘vl
v

3
3

(

server
Volume SYS: mounted

An installed Host Bus Adapter (HBA) that is compatible with
NetWare® and supports CD-ROM devices

There are no serial, parallel, or IDE device drivers for CD-ROM support.
Use a SCSI adapter.

The NWPA.NLM NetWare Peripheral Architecture™ (NPA) module

The disk driver file and necessary support modules

Some disk drivers consist of more than one file and some HBA
devices require additional support modules for CD-ROM
functionality. These files should accompany the HBA. For specific
file requirements, consult your adapter documentation.

NetWare 4.1 includes the third-party HBA device drivers that are
certified for NetWare 4.1 by Novell®. If the HBA is certified to
support CD-ROM devices, the necessary support modules are also
included with NetWare.

You can copy these files during installation, or you can copy them
from the NetWare distribution media using NWXTRACT.
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Procedure

Procedure‘;? 1. At the server console prompt, load the disk driver.
Type
LOAD [pathldisk_driver <Enter>

Replace disk_driver with the name of the disk driver specified in the
HBA documentation.

You might be prompted to supply command line values such as a
port or slot number for the HBA. Consult your HBA
documentation for this information.

For example, to load the disk driver for the Adaptec AHA-1522
SCSI HBA, you would type

LOAD [path]AHA1520.DSK <Enter>
LOAD [path]ASPICD.DSK <Enter>

Some files might automatically load. In this example,
ASPITRAN.DSK automatically loads when the AHA1520.DSK is
loaded.

If your disk driver autoloads the ASPITRAN.DSK driver, you need
to load either ASPICD.DSK or CDNASPLDSK

2. Load the NWPA NLM program.
Type
LOAD NWPA.NLM <Enter>

This is the device-independent software that interfaces with the
Media Manager.

3. Load the CDROM NLM program.
Type
LOAD CDROM <Enter>

Note WA When mounting a CD-ROM or changing a CD-ROM disc, CD-ROM devices
might be deactivated. Do not be alarmed. This deactivation occurs because
device configuration information is being updated.
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4. Mount the CD-ROM as a volume.
Type
CD MOUNT [object number] | [volume name]l <Enter>

Replace object number with the object number or replace volume
name with the volume name of the CD-ROM disc.

For example, to mount the NetWare_41 Documentation CD-ROM,
you would type
CD MOUNT NW410DOoC <Enter>

It might take several minutes to mount the volume, depending on
the size of the CD-ROM and the speed of your computer.

5. (Optional) To mount the CD-ROM as a NetWare volume each
time the server comes up, do the following:

5a. Edit your STARTUP.NCF file.
Add the following lines to the file:
LOAD [path] disk_driver

LOAD [path] ASPICD.DSK
LOAD [path] NWPA.NLM

If your disk driver autoloads the ASPITRAN.DSK driver, load
either ASPICD.DSK or CDNASPI.DSK.

5b. Edit your AUTOEXEC.NCF.
Add the following lines to the file:

LOAD CDROM
CD MOUNT [object number] | [volume name]

6. (Conditional) If you are using NetWare Directory Services™
(NDS) software, you must create an NDS™ Volume obiject.

Use the NetWare Administrator or NETADMIN utility to create a
Volume object so that the documentation volume appears in the
Directory tree.
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C Troubleshooting

Overview

This appendix identifies common trouble spots and offers possible
solutions.

The following topics are discussed in this appendix.

Topic Page
DATA_DIR Problems 47
DynaText Displays Empty Collections 48
COLLECTION Variable Problems 49

DATA_DIR Problems
The following message is displayed in MS Windows or WIN-OS/2:
Configuration Error: The DATA_ DIR variable in the

DYNATEXT.INI file is set to an invalid directory.
Verify this setting.

Explanation
DYNATEXT.INI expects the “Working Directory” to be the directory

containing the DynaText executable file, DTEXTRW.EXE. In a default
installation, this directory is \DOCVIEW\DTAPPWIN.
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Action

Verify that the “Working Directory” is specified correctly and try again
to view online documentation.

DynaText Displays Empty Collections

Explanation

Action

Collections appear without any books in them.

DynaText uses the collection paths mapped in the configuration files to
locate collections. The paths can explicitly name a language
subdirectory or name only the collection directory above language
subdirectories.

If the path specifies only the collection directory, DynaText then looks
to a platform-specific language variable to know which language
subdirectory to display. When this variable is not specified or is
specified incorrectly, DynaText displays an empty collection.

Either specify a language variable for the platform, as explained in
“Planning Online Documentation for Multilingual Use” on page 6, or
modify the collection path to explicitly name the language subdirectory,
as discussed in Chapter 4, “Configuring Online Documentation,” on
page 29.

Also make sure the collection you want is available for the language
you specified. Not all collections are available in all languages.
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COLLECTION Variable Problems

Explanation

Action

The following message is displayed in MS Windows or WIN-OS/2:

Configuration Error: The COLLECTION variable is not
specified in the DYNATEXT.INI file.

DynaText looks at the SYSCONFIG line of the DYNATEXT.INI file to
locate the SYSDOCS.CFG file which references public collections.
DynaText also looks at the COLLECTION line to locate private
collections.

The error message is displayed when both of these lines are empty or
invalid.

Specify the location of the SYSDOCS.CFG file in the SYSCONFIG line
and reference collections in the COLLECTION line. See Chapter 4,
“Configuring Online Documentation,” on page 29 for more
information.
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.ebtrc file, explained 32

A

Alias, creating to Macintosh viewer 22
AUTOEXEC.NCF file, using to mount CD-ROM as
NetWare volume 45

Books
moving within 34
opening 33
printing 36
viewing page numbers online 36

C

CDROM NLM, loading 44
CD-ROM. See Installing online documentation
(CD-ROM)
Clients, DynaText supported 3
Collections
empty, troubleshooting 48
explained 5
installing, with NCOPY 12
multilingual access 6
public versus private 5
referencing multiple 5
variable, troubleshooting 49
COLNAMES.LST file, explained 39
Configuration errors, explained

COLLECTION variable 49
DATA_DIR variable 47
Configuration files, editing 29. See also specific file
name
Configuring online documentation, explained 29

D

Deleting ElectroText directories, procedure 42
Directories used for online documentation

DynaText 37

ElectroText 41

language 39

Macintosh 40

MS Windows 40

0S/2 40

UnixWare 41
Directory trees, explained

DynaText 37

ElectroText 41
Disk space requirements for online documentation

accessed from CD-ROM 25

on a NetWare server 10

on Macintosh workstations 20

on MS Windows or OS/2 workstations 16
DOC directory, explained 39
Documentation database

default location 37

explained 1

multilingual access 6

public versus private 5
DOCVIEW directory, explained 40
DTAPPMAC directory, explained 40
DTAPPUW directory, explained 41
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DTAPPWIN directory, explained 40
DTDATMAC directory, explained 40
DTDATUW directory, explained 41
DTDATWIN directory, explained 40
DynaText viewer

compatibility with ElectroText viewer 1

default location, explained 37

overview 1

using 33
DYNATEXT.CFG file, explained 31
DYNATEXT.INI file

explained 31

troubleshooting 49

E

Editing configuration files, explained 29
ElectroText viewer
compatibility with DynaText viewer 1
directory structure 41
overview 1
removing 42

F

Files. See Configuration files; Directories; specific
file name

G

Graphics
printing 36
viewing online 34

H

Hardware requirements for online documentation
for CD-ROM mounted as NetWare volume 43
on Macintosh workstations 20
on MS Windows and OS/2 workstations 16
on NetWare servers 10

Index, using online Master 35
INSTALL utility, using
to install online documentation 9
Installing online documentation (CD-ROM)
access considerations 4
accessing online documentation from 25
mounting as NetWare volume 44
Installing online documentation (network)
access considerations 4
prerequisites 10
procedures 11
Installing online documentation (standalone
workstation)
access considerations 4
on Macintosh workstations 20
on MS Windows and OS/2 workstations 16
on UnixWare workstations 22

L

Languages, explained

directory structure for 39

memory requirements 6

specifying, for documentation on Macintosh
workstations 7

specifying, for documentation on MS Windows
and OS/2 workstations 6

specifying, for documentation on UnixWare
workstations 7
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Macintosh workstations
creating alias to DynaText viewer for 22
hardware requirements 20
installing online documentation on standalone
20
memory requirements 20
specifying documentation language for 7
Master Index, using online 35
Memory requirements for online documentation
on Macintosh workstations 20
on MS Windows and OS/2 workstations 18
Mounting a CD-ROM as a NetWare volume,
explained 43
MS Windows workstations
hardware requirements 16
installing online documentation on standalone
16
memory requirements 18
setting up DynaText viewer for 18
specifying documentation language for 6
Multilingual use of online documentation. See
Languages
Multiple collections, referencing in SYSDOCS.CFG
30

N

NCOPY utility, using to install online
documentation 10
NetWare volume, mounting a CD-ROM as 43
Network installation of online documentation. See
Installing online documentation (network)
Notes, allowing users to create 39
NWLANGUAGE parameter, using to set
documentation language 6
NWPA.DSK file
using with COROM.NLM 43

O

Online documentation
configuring 29
default directory structure 37
hardware requirements. Sec Hardware
requirements
installing. See Installing online documentation
overview 1
planning for 3
prerequisites. See Hardware requirements;
Memory requirements
using 33
using previous Novell, explained 1
where to install 3
Opening online books, procedure 33
OS/2 workstations
hardware requirements 16
installing online documentation on standalone
16
memory requirements 18
setting up DynaText viewer for 18
specifying documentation language for 6

P

Page numbers, viewing online 36
Prerequisites. See Hardware requirements;
Memory requirements
Printing from online documentation 36
Private collections
explained 5
referencing for Macintosh workstations 31
referencing for MS Windows and OS/2
workstations 31
referencing for UnixWare workstations 32
Program icon, creating for MS Windows and OS/2
viewer 19
Public collections
explained 5
referencing 30
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PUBLIC directory, explained 41
PUBNOTES directory, explained 39

R

Removing ElectroText directories, procedure 42
Requirements. Hardware requirements; Memory
requirements

S

Searching for text online 35

Standalone installation of online documentation.
See Installing online documentation
(standalone workstation)

STARTUP.NCF file, using to mount CD-ROM as
NetWare Volume 45

Stufflt archives, decompressing 20

SYSDOCS.CFG file, explained 30

T

Tables
printing 36
viewing online 34
Troubleshooting online documentation 47

U

UnixWare workstations
installing online documentation on standalone
22
specifying documentation language for 7

\'}

Viewer. See DynaText Viewer
Viewing online book page numbers, procedure 36
Volumes, mounting CD-ROM as NetWare 43

w

Workstations
Dynatext supported 3
See also specific workstation name

54 Installing and Using Novell Online Documentation



User Comments

We want to hear your comments and suggestions about this manual. Please send them to the following
address:

Novell, Inc. NetWare 4.1

Technical Publications Installing and Using Novell
MS C-23-1 Online Documentation

122 East 1700 South Part #100-002402-001
Provo, UT 84606 December 1994

US.A

Fax: (801) 429-3002
For technical support issues, contact your local dealer.

Your name and title:

Company:

Address:

Phone number: Fax:

| use this manual as QO anoverview Q atutorial Q a reference Q aguide Q

Excellent Good Fair Poor
Completeness Q ] Q Q
Readability (style) a a ] Q
Organization/Format Q Q a Q
Accuracy Q Qa Qa Q
Examples Q Q a Qa
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Usefulness Q Q Q Q

Please explain any of your ratings:

In what ways can this manual be improved?

You may photocopy this comment page as needed so that others can also send in comments.



